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Introduction

The MiniNova Editor is a standalone application which allows you to edit your MiniNova synthesiser's patches
from your computer. The editor gives you a clearer idea of what's happening inside the Nova synth engine by

grouping controls and allowing you to see everything going on at once; without needing to menu dive.

The MiniNova Editor is a real-time editor, meaning any changes you make in the software change the sound of

the synth. Likewise, the software will update if you change the parameters on the MiniNova hardware.
To download the MiniNova Editor:

1. Gotodownloads.novationmusic.com.
2. Navigate to the MiniNova downloads page.

3. Find and download the MiniNova Editor.

This user guide also refers to the MiniNova user guide and the MiniNova Librarian. MiniNova Librarian gets
installed at the same time as the MiniNova Editor. You can download the MiniNova user guide separately from

the Novation Downloads page:
downloads.novationmusic.com

The MiniNova editor software consists of tabs down the left-hand side and a main window on the right. To

change the main window on the right, click the tabs on the left-hand pane. The selected tab shows blue.
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Patch Section

The Patch section of the MiniNova Editor allows you to navigate through your connected MiniNova's patches.
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« Patch - shows the currently selected patch on your MiniNova.

« Patch Up / Patch Down - Move the patch up and down on your MiniNova. The patch on your MiniNova
updates in real-time. Changing the patch on your MiniNova hardware also updates the MiniNova Editor.

« Send to Librarian - Opens the MiniNova Librarian and opens the currently selected patch. You can
then store this patch on your computer.

+ Launch Librarian - Opens the MiniNova Librarian.

«+ Last Parameter - Displays the last parameter you changed on either the hardware or software.

+ Value - Shows the value the Last Parameter was changed to.

MiniNova Editor Perform Tab

12
Perform 1o

The Perform tab gives you access to edit and change the Tweak parameters and use the Animate controls on

3456178 Tweak
3456738 Animate
your MiniNova.

The tab gives you a quick view, so you can see which Tweak and Animate parameters are assigned for your

selected patch.

MiniNova's Tweak Controls:
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MiniNova's Animate Buttons:
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Tweak

Tweak

AmpEnv Attack Filter Balance Oscl Sync Depth Portamento R...
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Noise Mix Level Chorus1 Rate Chorusl Mod ... Dry:Wet Balance

In the Tweak section, you can edit the eight Tweak parameters (1 - 8 (FX Level)) selectable in the Perform
section. Click on the parameter name to change that Tweak target and use the controls to adjust the Tweak

initial values.

For more information on the Tweak section, see pages seven and eight in the MiniNova user guide.



Animate

Animate
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Using the buttons you can audition the effect of your MiniNova's animate buttons.

You can't edit the Animate parameters in this tab, however, you can edit the Animate buttons in the

Modulation, Envelopes, and LFOs tab.

For more information on the Animate section, see page eight in the MiniNova user guide.



Oscillator Mixer Voice Tab

Oscillator 1 | |pvn|

Oscillator 2 |/]*#[]
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The Oscillator Mixer Voice tab shows you at a glance:

Each Oscillator's Wave shape.
« The coarse and fine-tuning for each oscillator

« The mix levels of the three oscillators, Ring Mod and Noise oscillator.

The Voice setting for the Patch.

Oscillators

Oscillator

Pulse Width Wave
/Wave Table /Table
Index Interpolation y

+0 +12

Virtual Detune Density
Sync Cents Detune Density Semitone Pitch Wheel

The Oscillator panel allows you to control all the settings for each of the three Oscillators.
To change the Wave Shape, click the Wave's image to show a list of the available wave shapes.

For more information on the Oscillator settings, see pages 15 - 17 in the MiniNova user guide.



Common

Oscillator Off Rate Depth

Drift Fixed Note Mod Wheel Vibrato

The Common section refers to parameters common to all three oscillators.

For more information on the Common oscillator settings, see pages 16 and 17 in the MiniNova user guide.

Noise

Click the Type dropdown to change the Noise oscillator type.

For more information on the Noise Parameter, see page 17 in the MiniNova user guide.

Mixer

Effects

The Mixer lets you adjust the level of the three oscillators, ring modulators and noise oscillators.

To adjust the level, click inside the bar to the left of the oscillator name.

The Effects control controls the level of the PreFXLvl and PostFXLvl parameters.

For more information on the MiniNova's Mixer, see page 17 in the MiniNova user guide.



Unison

Unison

Voices

1

Unison
Detune

Click in the Voices box and drag up and down to adjust the number of voices.

For more information on the Unison setting, see page 20 in the MiniNova user guide.

Portamento

Portamento

Pre Glide
+2

Mode

Exponential

Click in the Pre Glide and Mode boxes and drag them up or down to adjust the values.

For more information on the Portamento setting, see pages 20 and 21 in the MiniNova user guide.

Polyphonic Mode

Polyphonic Mode Mono



Click the Polyphonic Mode dropdown to choose from the available modes.

For more information on the polyphony setting, see page 21 of the MiniNova user guide.

Amp Envelope

Attack Slope

Decay Slope
—

Attacler’ack Velocity Repeat  Level Track

DecavlTrack Trigger

Sustain Rate Mono | Re-Trigger

Sustain Time i
Animate Off

Use the handles on the yellow graph to adjust the ADSR times and levels, and use the faders to the right to
adjust the slope of the ADSR.

For more information on the Amp Envelope, see pages 21 to 23 in the MiniNova user guide.
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Filter 2

At a glance, the Filter tab shows the:

« Filter type
« Cut-off frequency
* Resonance

« Filter Drive
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Filters

Keytrack Q Normalise
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Drive
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LP6NoRes
Filter Env
Amount

Frequency Resonance

|
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Filter Env Diode

Amount
Frequency Resonance

Thefilter section is divided in two with a set of parameters for each Filter. To change the filter type, click the

visual representation in the middle to see a drop-down list.

For more information on the Filters, see pages 17 to 20 of the MiniNova user guide.

Filter
Balance

For more information on Filter Balance see pages 18 and 19 in the MiniNova user guide.
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Filter Routing

Routing

There are six Filter Routing options, as shown by the graphics. The currently selected Filter Routing option is

highlighted. Click another graphic to change the Filter Routing.

For more information on Filter Routing see pages 19 and 20 in the MiniNova user guide.

Filter Envelope

Attack Slope
Decay Slope

AttaCkITrack Velocity Repeat  Level Track

Decay Track
\

Trigger
Sustailn Rate Mono | Re-Trigger

Sustain Time .
— | Animate Off

Use the handles on the yellow graph to adjust the ADSR times and levels, and use the faders to the right to
adjust the slope of the ADSR.

For more information on the Filter Envelope, see page 23 of the MiniNova user guide.
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Modulation, Envelopes, and LFO tab

. ojejoj0o0j0| | |
Modulation .uuuuuun

Envelopes

The Modulation, Envelopes, and LFO tab shows you at a glance which modulation slots are in use, the rough

shapes of each Envelope and each LFO's wave shape.

Edit Modulation Slot

——Edit Modulation Slot

Off
Rate Slew  Common Delay Sync

" Off Sync 0 Phase Legato | Trigger
Lfo2 Unipolar Y g gg
Triangle " IOneShot " KeySync Fade In | Fade Type

Direct

Usediin |
mod slot

Animate

Destination

Delay2 Time

To edit a modulation slot you can click one of the 1-20 modulation slots in the top left corner then go through

each of its Source, Animate and Destination parameters. Source parameters are on the right-hand side.

For more information on editing modulation slots, see pages 26 and 27 of the MiniNova user guide.

Modulation Slot Table

Animate Destination

g
£

5 After Touch Filterl Frequency
ﬂ After Touch Filter2 Frequency
- Mod Wheel 0sc123 Pitch
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The table shows the 20 modulation slots at a glance. You can change the parameters for your mod either by
clicking the table or in the Edit Modulation Slot section above. To adjust the mod depth, you can click and drag

the Depth sliders in the table above.

For more information on the Mod Matrix, please see page 26 of the MiniNova user guide.
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Effects Tab

Effects 12345 Arp Voc VT

The Effects tab shows you at a glance which effects slots are in use for the currently selected patch.

Effect Controls

BYPASS Slot 1: EQ

EQ Compressor 1
Compressor2 Distortion 1
Distortion 2 Delay 1

Delay 2 Reverb 1
Reverb 2 Chorus 1
Chorus 2 Chorus 3

chorues  Gator 0.5 0.1 1.0 0.5 0.8 0.8

Bass Level Mid Level Treble Level Bass Freq Mid Freq Treble Freq

The section at the top of the effects tab allows you to change the effect for the selected slot and change the

parameters of that effect.

For more information on the Effects, see pages 27 to 31 of the MiniNova user guide.

Effects Slots

Slot Slot Slot Slot Slot FX Wet Level
1 2 3 4 )

Amount BN Amount Amount Amount Amount

0] Chorus 1 Delay 1 Delay 2 Reverb 1

Click a slot to select it and edit the effect and parameters in the section above.

Effect Slot Routing

Routing 6 (& =& =

152 +3+445 |8 2.8, 0. 5

Click one of the eight routing options to choose how the effects slots are routed.

For more information on effect slot routing, see page 28 of the MiniNova user guide.
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Arpeggiator

Arpeggiator Chord

Length | g

 DEEEEEEE

Sync| 16th Mode Up Octave | 1 Pattern | Arp Edit Latch

On

Select the tab at the top of the section to enable and change the patch's Arpeggiator settings.

For more information on the Arpeggiator, please see page 14 of the MiniNova user guide.

Vocoder

Formant Filters -
- - Sibilance

Vocoder Carrier Modulator Width Shift Spread Resonate Decay Depth Threshold Release

on Freeze Mode | Normal Type | High Pass Source | Audion

Select the tab at the top of the section to enable and change the patch's Vocoder settings.

For more information on the Vocoder, please see page 33 of the MiniNova user guide.

Vocal Tune

Vocal Tune
Vibrato

Amount Mod Pitch Shift  Pitch Bend Threshold Release

Scale Played Key © Insert PreFX

Select the tab at the top of the section to enable and change the patch's Vocal Tune settings.

For more information on the Vocal Tune effect, please see page 32 of the MiniNova user guide.
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Pan

Position Rate —T— Depth

Sync Rate 0)i

Adjust the Pan settings for the patch.

For more information about the Pan control, please see pages 27 and 28 in the MiniNova user guide.
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Novation Notices

Troubleshooting

For help getting started with your MiniNova, visit:
novationmusic.com/get-started

If you have any questions or need any help at any time with your MiniNova, visit our Help Centre. Here you can

also contact our support team:
support.novationmusic.com

We recommend you check for updates to your MiniNova so you have the latest features and fixes. To update

your MiniNova's firmware you need to use Components:

components.novationmusic.com

Trade Marks

The Novation trademark is owned by Focusrite Audio Engineering Ltd. All other brands, products, company
names, and any other registered names or trade marks mentioned in this manual belong to their respective

owners.

Disclaimer

Novation has taken all steps to ensure the information given here is correct and complete. In no event can
Novation accept any liability or responsibility for any loss or damage to the owner of the equipment, any third
party, or any equipment which may result from this manual or the equipment it describes. The information
provided in this document may be changed at any time without warning. Specifications and appearance may

differ from those listed and illustrated.

Copyright and Legal Notices

Novation is a registered trade mark of Focusrite Audio Engineering Limited. MiniNova is a trademark of

Focusrite Audio Engineering Plc. 2022 © Focusrite Audio Engineering Limited.
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